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Criteria 1
1:2.1

Number of Certificate/Value added courses offered and online courses of MOOCs,
SWAYAM, NPTEL etc. (where the students of the institution have enrolled and
successfully completed during the last five years)

Year Name of Course Total no of students
Speaking Effectively 1
Design Thinking -A Primer 4
Product Design and Development 3
Entrepreneurship and IP Strategy 1
2021-22 Introduction to Machine Learning I
Data Analytics with Python 2
Training Program by Campus Credential
module 4 28
Soft Skill Training Session of CC Module 4 25
Project Based Learning Training 276
Improving programming skills on Coding
Websites. 107
Advanced Excel Course 230
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r - ___ Notice S
Academic Year: 2021-22 Date: 17/06/21

All Students & Faculties are hereby informed that; “SWAYAM NPTEL
Courses” (https://swavam.gov.in/NPTEL) Enrollment & Registration is

. OPEN for July-August 2021 Semester.

All Faculties & Students are mandatorily registered and enrolled at least
one NPTEL course.

For any queries, please contact your departmental coordinator;

You all are request to take benefits of SWAYAM NPTEL course.

Ny

%r Wadhwa

Prof. Rohit Jadhao Dr.Lalitku

LRDC Incharge P\ ~Principal
.,J. Nutzn M= ‘nstitute
_ GE & -
Cc; “Samarth Vi upur

All Head of Department:
All Coordinators;
All Notice Boards
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Academic Year: 2021-22 Date: 17/12/21

All Students & Faculties are hereby informed that; “SWAYAM NPTEL
Courses” (https://swavam.gov.in/NPTEL) Enrollment & Registration is

. OPEN for Jan-April 2022 Semester.

All Faculties & Students are mandatorily registered and enrolled at least
one NPTEL course.

For any queries, please contact your departmental coordinator;

You all are request to take benefits of SWAYAM NPTEL course.

‘/Prts?ﬁl‘gﬁ%rjadhao Dr.Lalitkuriar Wadhwa

LRDC Incharge ) "i”fincigg‘l
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All Head of Department;
All Coordinators:

All Notice Boards




Record No.: ACDM/R/033

Nutan Maharashtra Vidya Prasarak Manda’s Revision: 00

Nutan Maharashtra Inst. of Engg. & Tech. | Date:

Request for organization of Event

Department: E&TC Academic Year: 2021 - 2022 Date:22/12/21

To,

The Principal,

Through: The HOD (Department of Electronics and Telecommunication)

Subject: Permission for organization of Placement Training Program by Campus Credential for TE

students (‘n o \&q’ I,’>

Respected Sir,

In context to above subject, we request permission to organize the Placement Training Program by
Campus Credential for TE students in online mode.

>
>

N NN SN N

-

Name of Event: Placement Training Program by Campus Credential

Purpose: To make student placement ready , conducting sessions on Aptittude, Reasoning, Soft
Skill as per provided schedule.

Expected audience: 27

Duration ( date / s , time ): 03/01/2022 onwards

Budget: -

Sponsorship ( if any):-

Affiliations ( if any):-

. Thanking You. Yours faithfully,

e

Coordinator

Remarks:

Head of theDepartment
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Nutan Maharashtra Inst. of Engg. & Tech.

Record No: ACDM/R/024

Revision: 00

Date:15/06/2016

Notice

Department: ENTC Academic Year: 2021- 2022
Year: Third

Semester: I
Date: 24/12/2021

All TE students are hereby informed that Placement Training Program by Campus Credential is

scheduled on 037 January 2022 in online mode. All have to attend these training sessions. (™Mo AAch

@Uﬁm}“/ \)0’/
Prof. Bhagyashri Warhade Dr. ¥ilas Deotare

T&P Coordinator HOD E&TC

—

\é=
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=)
Dr. Lali 'ur% Wadhwa

Principal




Record No.: ACDM/R/036

Nutan Maharashtra Vidya Prasarak Mandal’s | Revision: 00

: 15.06.2016
Nutan Maharashtra Inst. of Engg. & Tech. Deteel el

Report of Placement Training Program

Department: E&TC Academic Year: 2021-22 Date: 20/05/2022
To,

The Principal,

Through: The HOD E&TC

Subject: Placement Training Program conducted by Campus Credential in online mode. QV\ B VATY C\)

Respected Sir,

The placement training program was conducted from 3™ January 2022 to 10* May 2022. The sessions were
conducted by Mr. Ganesh Bhosle, Mr. Vinay Raikar, Mr. Ashish Ratani, Mr, Karan Batra. Total 28
students have registered in which quantitative aptitude, logical reasoning, verbal ability, group discussion,
personal interviews, technical sessions were conducted. They uploaded practice test on campus credential portal
for which each student has allotted user ID and password. Students were given sufficient time for solving test.
Students have also solved company specific practice test.

Name of Expert: Mr. Ganesh Bhosle, Mr. Vinay Raikar, Mr. Ashish Ratani, Mr. Karan Batra.(Campus
Credential Trainer)

No. of Participants:28
Faculty Coordinator and Members: Prof. Bhagyashri A. Warhade, T&P Cordinator

Sr. No. Date Title Important details of events
1 3 Jaﬂr:ua:y 2022 Placement Training Program Outcome of this program: Students will
tz%%g May ain  knowledge of -aptitude, logical

easoning, verbal ability. Its results into|

increase in placement ratio.

Photos are enclosed herewith

Thanking you.

Yours faithfully
;{: 0 R

Prof. Bhagyashri Warhade
Assistant Professor
E&TC Department




Department of E&TC Engineering

Training Program By campus Credential Assessment sheetQ'\ o dlad

( AY 2021-22)

SrNo. | RollNO Name of Student Mar':sog”‘ o
1 102 Bagate Vedant Vitthal 60
2 104 Bokka Pawankumar 74
3 110 Gaikwad Sagar Arun 70
4 111 Kalokhe Akshada Uttam 78
5 112 KUMAR ADITYA 84
6 114 Mate Sejal Chandrashekhar 80
7 116 Sujal patil 56
8 117 Pawar Mrunmayee Sampat 64
9 121 Sawant Harshada Sandip 72

10 122 Singh Namrata Udham 76
1 123 Tote Varad Vidyanand 62
12 124 Anurag Raju Wagh 60
13 131 Patil Sanskruti 64
14 132 Pawar Shreeram Raju 78
15 136 Omkar Jeetendra Kalekar 70
16 138 Omkar Shete 76
17 139 Om Sakharam Bhor 64
18 143 USHA DNYANESHWAR ARAGADE 62
19 144 Deshmukh Nikita Namdev 82
20 146 Ruchika Kalagate 74
21 147 Mahajan Sakshi Sanjay 58
22 149 Sherkhane Pooja Dilip 64
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Nutan Maharashtra Vidya Prasarak Mandal’s

Nutan Maharashtra Inst. of Engg. & Tech.

Record No: ACDM/R/024

Revision: 00

Date:15/06/2016

Notice

Department: Mechanical Academic Year: 2021- 2022
Year: TE

Semester: 1T
Date: 21/12/2021

All TE students are hereby informed that Softs skill training session of Campus Credential module 4 are
scheduled from 3/01/2022. All registered students attend the sessions regularly.

i

Prof. Prashant Maske
T&P Coordinator

H@K

HEAD OF THT NELARTMENT

M ~{ 8 2ring Nut&n f\f[ah

o
. : alan:
Nutan M. 13, & Tech, Taleg:

N

Principal
Nutan Maharashtra Institute
«, OfEngg & Technology
amarth Vidya Sankul” Vishnupuri
Talegaon Dabhade, 410507

::f:j's.i:.tr'a- 'nst. of Engg, g Tech
—aihiade, Pune - 419 507 .



CC Module 4 syllabus
Full Company
Number of Classroom Hours (70) Paper Specific Test
Test Papers
Subject
Quant Verbal Logical GD/P1 Total
Online
Training
Test
Class-room Yes 25+ | Yes 30+
30Hrs 18 Hrs 12 Hrs 10Hrs 70 Hrs
Teaching Tests Tests)
1 12 Hrs | 6 Hrs | 12 Hrs 30Hrs Online full length tests &
Video
online online online 9 Hrs online company specific tests are
Assignment & )
video video video video available
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Gaurav Pande Rahul Patil (host, me)




Record No.: ACDM/R/

Revision: 00
Nutan Maharashtra Vidya Prasarak Mandal’s P

Date: 15.06.2016

Nutan Maharashtra Inst. of Engg. & Tech.

Report of Softs Skill training sessions SRR
Date: 4/2/2022
To,
The Principal,
PCET-NMIET,
. Talegaon Dabhade,
Pune — 410507.

Subject: Softs Skill Development training sessions report conducted by Campus Credential

The softs skill training program conducted by campus credential TE mechanical students is

completed. All the sessions conducted were interactive and as per mentioned in module, logical reasoning,
verbal ability, technical training, group discussion all details covered.

No. of students enrolled 25
Softs skill development sessions conducted from 3/01/2022 to 29/01/2022

TPO Coordinator
Prof, Maske Prashant

\
P.nn/clpal

N“t:?é\dm & Techuology o
Talegaon Dabhade, 41050
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Department of Mechanical Engineering
Softs Skill Training By campus Credential Module 4 Assessment sheet
SrN| .. . Roll Marks out of
& Division Nuiber Name of Student 100
1 B 101 Patil Omkar Akaram 78
2 A 115 Deshmukh Aniket Jayram 76
3 A 150 Kulkarni Ketan Ganesh 66
4 A 135 Paritkar Suprap Suhas 74
5 A 142 Aher Mayur Bharat 66
6 A 102 Jagadale Shardul Rajendra 60
7 B 113 Khalkar Ashvin Kisan 56
8 B 136 Kamble Prajwal Chandrashekhar 72
9 B 124 Mune Shubham Gitaram 48
10 B 139 Mayur Dnyaneshwar Lokhande 68
11 B 119 Lokare Tushar Ankush 66
12 B 142 Naman Nandurkar 72
13 A 109 Bhosale Pratik Sukhadev 54
14 A 106 Bandal Bhushan Rajendra 58
15 B 154 Salunkhe Mihir Chandrakant 74
16 A 119 Gaikwad Sudarshan Sanjay 70
17 A 136 Patil Sohankumar 60
18 A 137 Pokharkar Ashutosh Shivaiji 68
19 A 134 Parbhane Tejas Sanjay 50
20 A 138 Sherkar Pradesh Laxman 56
21 A 152 More Mayur Yogesh 64
22 B 151 Pimpale Shubham Jagannath 68
23 A 108 Bhalekar Yugandhar Nilesh 70
24 A 132 Bhavesh Nikam 56
25 A 107 Saurabh Sadashiv Baviskar 78
Prinefpal

Nutan Maharashtra Institute
of Engg. & Technology

*Samarth Vidya "o

Talegaon Dabhate, 410507

mul” Vishnupuri




Campus Credential Assessment test result

of Mechanical Students

Marks
Sr.No.| Roll No. Name of Student out of

100
1 TEMA103 [Argin Attar 68
2 TEMA104 |Prithviraj Awate 72
3 TEMA109 |Bhokare Nikhil Anil 58
4 TEMA112 |Chaudhari Mayur 54
5 TEMA121 |Dasme Rushikesh 52
6 TEMA122 |Vaibhav Deokar 58
T TEMA123 |Deshmukh Saheel 78
8 TEMA125 |Dhame Pratiksha 76
9 TEMA126 {Dhore Yash 80
10 TEMA127 |Doke Arnav 60
11 TEMA133 |Gawali Aniket 82
12 | TEMA142 |Jadhav Kranti 74
13 | TEMA154 |Nitin Kanhurkar 72
14 | TEMA155 |Karkare Sanket 76
15 | TEMB107 |Mahule Vaibhav 60
16 | TEMB108 [Mandavgane Shubham 58
17 TEMB110 |Mandlik Aniket 64
18 | TEMB112 |Mankar Himanshu 54
19 | TEMB115 |More Bhaskar 76
20 TEMB116 |Mule Omkar 66
21 | TEMB118 |Naphade Ankit 78
22 | TEMB127 |Patil Amol 58
23 | TEMB148 |Sinha Ankit 80
24 | TEMB160 |Vekhande Sahil 68
25 TEMB161 |Walke Omkar 50




Nutan Maharashtra Vidya Prasarak Mandal's
NUTAN MAHARASHTRA INSTITUTE OF

ENGINEERING & TECHNOLOGY

Approved by AICTE |  Accredited by NAAC& NBA | Affiliated to SPPU
“Samarth Vidya Sankul”, Vishnupuri, Telegaon Dabhade, Pune - 410507
Tel. No.02114-231666 | E-mail: nmiettalegaon@gmail.com | Web : www.nmiet.edu.in

Academic Year: 2021-22
Department: First Year Engineering e Date: 03/01/2022

To,
The Principal,
Through: The HOD (FE)

Subject: Permission for organizing The Project Based Learning (PBL) Training to FE Students
Respected Sir,

In context to above subject, we request your permission to conduct The Project Based Learning (PBL)
training to FE Students

Name of Event: The Project Based Learning (PBL) Training
Duration (dates/time): 10" Jan 2022 to 14™ Jan 2022 / 30hrs
e Budget: NIL
® Sponsorship (if any)
e Affiliations ( if any)
Thanking You. i
Yours faithfully,

Coordinators : Prof. Harshal Chaudhari

Remarks: \@_’% '
Dr.Shekhar Rahane

Head of the Department
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Nutan Maharashtra Vidya Prasarak Mandal's

NUTAN MAHARASHTRA INSTITUTE OF
ENGINEERING & TECHNOLOGY

ESTD : 1906
Approved by AICTE |  Accredited by NAAC& NBA | Affiliated to SPPU
“Samarth Vidya Sankul”, Vishnupuri, Telegaon Dabhade, Pune - 410507
Tel. No. 02114 -231666 | E-mail: nmiettalegaon@gmail.com [ Web : www.nmiet.edu.in

Department: First Year Engineering Date: 18/01/2022

To,

The Principal,

Through: The HOD (FE)

Subject: Submission of the Report of Project Based Learning (PBL) training to FE Students
Respected Sir,

With above reference, we have successfully organized and completed The Project Based Learning (PBL)
training to FE  Students on 10" January 2022 to 14 January 2022. The details are given below.

No. of Participants: 276

Faculty Coordinator and Members:

Sr. Date & Time Title Important details of events
No.
1 10" January The Project Based Learning (PBL) | 276 Students attended the workshop
2022 to 14™ | training
January 2022
Thanking You. /

Coordinator: 1) Prof. Harshal Chaudhari

o2
Dr.Shg:-LRahane

Head of the Department

o o
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Date :18/01/2022

To,

Prof. Prema Sahane

‘ NMIET,

Talegaon Dabhade Pune.

Subject: Thanking Letter

Respected Ma’am,

It is our proud privilege to express sincere thanks for extending your invaluable support.

We are grateful to you for conducting an expert session on “PBLTraining” on 10/01/2022 to
14/01/2022 for FE students. We are quite confident that our students will be highly benefited by your

valuable inputs.

. Thanking you and looking forward for your co-operation in future as well.

Prof@fal Chaudhari Dr.ShekharR/ahane

(Coordinator) /: =N (HOD FE)




PBL Training
* Indicates [eq“ked q“es_tiop

1. Email *

2. Name of Student *

3. RollNo.*

4. Mail Id *

5. What are some benefits of project-based learning in education? *
A. It enhances students' problem-solving skills.
B. It helps students to develop their creativity.
C. It improves teamwork and collaboration among students.
D. It ensures students memorize all information for tests.
Choose the correct answer from the options given below.

Mark only one oval.

(D ABand COnly
(O AB.Donly
(OBDonly ¢

(O ABCandD

https:/idocs.google.comforms/d/1z Ca ﬂasGCMG]Qq!‘IBPZdY RoBbeYZZa?WSg!edlt
234 1'}. =

]

1 point

1 point

1 point

1 point

13



6. Which of the following is not a suitable basis of designing problem? * 1 point

Mark only one oval.

() Book

(D News Paper

() Research paper
() Past Assignments

7. The project method of teaching is best associated with the philosophy of * 1 point

Mark only one oval.

(D John Dewey

. () Max Rafferty

(D B.F. Skinner

C) Option 4

8. Group Working can be improved by: * 1 point
Mark only one oval.

C) Questioning other ideas
(O Talking with peers

C) Present and defend ideas,
C) All of Above

9. What is the first step in seven jumps of PBL? * 1 point

Mark only one oval.

() Identification of the problems
() Hypothesis formation

(O Clarification of terms

() Brain storming

https://docs.google.com/forms/d/1zUadul OtF JTasGCM6jQqhBP2dYRoBbx5Y22a7W5sg/edit
Nuta nstitute

L e 7 Vishnupurd




NutanMaharashtraVidyaPrasarakMandal’s
Nutan Maharashtra Inst. of Engineering
&Technology
DepartmentofComputerEngineering

RecordNo.:ACDM/R/

Revision:00

Date:15/06/16

AcademicYear:2021- 2022 Sem-1

NOTICE

Date: 18/11/2021

All the students of Computer Engineering Department are hereby informed that our department is

going to organize the “A value-Added Course Session on “Improving programming skills on

Coding Websites™™ for Five days. This Hands-on expert session is scheduled from 23rd Nov 2022.

. To 27t Nov 2022. All student’s complete registration process using mention link on or before

registration end date.

Refer below table for registration details:

Sr.No. | Details
1 Registration link https://mail.coogle.com/w/0/4starred/FMfcgzGsltTqOxbl
LSBZSQbmpkQPgPDs
2 Registration mode Online
3 Venue Virtual Mode

EvéntCoordinator

Pripcipal




Sr.No.

Date

Title

Important Details of Event

27/07/2019

Hitbullseye Mock Interview

Mock interviews help candidates reduce
their  stress and anxiety  about
interviewing.

2. Mock interviews héfp you boost your
confidence.

3. Mock interviews provide you with
constructive feedback in a low-stress
environment.

4. Mock interviews can help you prepare

for behavioral-based interview questions.

Thanking You.

T&P Activity: Hitbullseye GD/PI Sessions

Instructor: Ms. PoonamAswani
Date: 27/07/2019

Time: 09:00 am to 05:00 pm
B o Ens samsns o e

Screen Shots:

HOD

Computer Department




Nutan Maharashtra VidyaPrasarak Mandal’s (NMVPM'’s) T,
NUTAN MAHARASHTRA INSTITUTE OF ENGINEERING AND

TECHNOLOGY (NMIET)
Under Administrative Support - PimpriChinchwad Education \ @
Trust (PCET) e/
esTo- 1ot
Approved by AICTE Accredited by NAAC Affiliated to SPPU

Department of Computer Engg.
AY:2021-2022

Date: 23/11/2021
Report On “A value-Added Course Session on “Improving programming skills
on Coding Websites”

Objective of Activity:

1. The objective of this expert session is to provide opportunity for students and

faculty members to enrich their knowledge in the area of Website Programming.

Number of Student Involved: 107 Participants

Speaker Prof. Rahul Dagade
Freelance

Corporate Trainer

Brief Description of Activity: Our department of Computer Engineering has planned to
organize , A Value-Added Course along with hand-on session from 23rd to 27" November

2022 was conducted to Improving programming skills on Coding Websites.

The rapid development in Computer Technology, during the last thirty years or so, has led to a

growing interest in the subject of Improving programming skills on Coding Websites.

The main objective of this expert session was to Improving programming skills on Coding

Websites.

Y




Nutan Maharashtra VidyaPrasarak Mandal’s (NMVPM’s)
NUTAN MAHARASHTRA INSTITUTE OF ENGINEERING AND /
TECHNOLOGY (NMIET) ;
Under Administrative Support - PimpriChinchwad Education '
Trust (PCET)

ESTD : 1806

Approved by AICTE Accredited by NAAC Affiliated to SPPU

Department of Computer Engg.

Photos:

/

Evént Coordinator

mpu er Engg. Principal



SCHEDULE

Day1-6 hrs.
Module 1

e Overview of Cand C++
e Basic syntax and structure of C and C++ programs
e Data types, variables, and constants
e Operators and expressions
» Control flow: decision making and looping constructs
Module 2
' e Functions in C and C++
» Function prototypes and parameter passing
¢ Scope and lifetime of variables
¢ Header files and function libraries
» Modular programming concepts

Day2-6 hrs.
Module 3

Arrays and multidimensional arrays
e Stringsin C and C++
= String manipulation functions
. s Character handling functions
e Array processing and manipulation techniques
Module 4
¢ Pointers and pointer arithmetic
« Dynamic memory allocation in C and C++
» Memory management functions (malloc, calloc, realloc, free)
» Pointers and arrays

e Pointer to functions

Nuts




Day3-6 hrs.
Module 5

e Structure definition and initialization
e Accessing structure members
* Nested structures and arrays of structures
¢ Unions and their applications
e Structures vs. unions
Module 6
e File operations in Cand C++
e File opening, reading, writing, and closing
. e Sequential and random file access
e Error handling and file management
¢ File manipulation functions
Module 7
o Classes and objects
e Constructors and destructors
e Member functions and data members
¢ Inheritance and polymorphism

s Operator overloading and function overloading

Day 4-6 hrs.

. Module 8

e Templates and generic programming

e Exception handling

¢ Standard Template Library (STL)

¢ Smart pointers and memory management

e Multithreading and concurrency in C++

Module 9

e Overview of web development technologies



 Client-side vs. server-side scripting
e Introduction to HTML, CSS, and JavaScript

» Basics of web servers and web browsers
Day 5-6 hrs.

Module 10
» CGIl programming with C/C++
» Using C/C++ libraries for web development
» Building dynamic web applications with C/C++

* Security considerations in web development with C/C++



TECHNOLOGY (NMIET)

Trust (PCET)

Nutan Maharashtra Vidya Prasarak Mandal's (NMVPM's)
NUTAN MAHARASHTRA INSTITUTE OF ENGINEERING AND

Under Administrative Support - Pimpri Chinchwad Education

ESTD - 1906

Approved by AICTE

Accredited by NAAC

Affiliated to SPPU

Department of Computer Engineering

Evaluation Report

AY:2021-2022

Sr.No Name of Student Score(Out of 50) | Remark

1 | Suyash Subhash Alekar 43 qualified :
2 | Atharva Anil Argade 44 qualified
3 | Suyash Tatyaso Awate 29 qualified
4 | Prasad Datta Bandgar 43 qualified
5 | Nayan Nitin Bhamare 33 qualified
6 | Pranav Kishor Bharambe 36 qualified
7 | Sahil Pradip Bhirud 35 qualified
8 | Akshay Shivaji Birhade 37 qualified
9 | Tanmay Nitin Budage 45 qualified
10 | Richa Santhosh Chirayil 42 qualified
11 | Harshal Prakash Chopade 42 qualified
12 | Abhishek Santosh Dalvi 36 qualified
13 | Snehal Sunil Desai 35 qualified
14 | Manoj Vilas Devare 37 qualified
15 | Srishti Shivajirao Dhamal 43 qualified
16 | Aditya Rajesh Dharmadhikari 33 qualified
17 | Siddhesh Prashant Dhekane 36 qualified
18 | Amruta Baban Gadekar 35 qualified
19 | Dhanashri Vilas Gajare 37 qualified
20 | Priya Vijay Ghare 43 qualified
21 | Sampada Gangadhar Ghorpade 44 qualified
22 | Pooja Sanjay Gore 29 qualified
23 | Onkar Changdeo Indalkar 31 qualified
24 | Amol Ganpat Ingale 35 qualified
25 | Shreya Shivaji Jangam 12 disqualified
26 | Tanmay Sunil Kabade 43 qualified

&




Nutan Maharashtra Vidya Prasarak Mandal’s (NMVPM's) T
NUTAN MAHARASHTRA INSTITUTE OF ENGINEERING AND

TECHNOLOGY (NMIET) - @8
7 . Under Administrative Support - Pimpri Chinchwad Education N\ e/
=t Trust (PCET) o s
Approved by AICTE Accredited by NAAC Affiliated to SPPU
Department of Computer Engineering

27 | Abhishek Yashwant Kadam 44 qualified

28 | Sonal Suryakant Kale 29 qualified

29 | Rohit Sadashiv Kalkhaire 43 qualified

30 | Kishor Balasaheb Kokate 33 qualified

31 | Prathamesh Parasharam Kokitkar 36 qualified

32 | Akanksha Anand Kshatriya 35 qualified

33 | Shruti Narhari Kulkarni 37 qualified

34 | Piyush Namdeo Lohar 45 qualified

35 | Sakshi Deepak Mahadik 42 qualified

36 | Pratik Vasant Mahajan 42 qualified

37 | Darshan Bipin Mankeshwarkar 36 qualified

38 | Akash Vitthal Mhatugade 35 qualified

39 | Prerana Suresh More 37 qualified

40 | Dishan Sushant Mukherjee 43 qualified

41 | Samcharles Balan Nadar 33 qualified

42 | Prashant Shivaji Nikam 36 qualified

43 | Priyanka Mahesh Nimbalkar 35 qualified

44 | Sakshi Vilas Nimbalkar 37 qualified

45 | Pratiksha Venkat Ogale 43 qualified

46 | Sumeet Kashinath Pakhare 44 qualified

47 | Dhanshree Laxmikant Pandav 29 qualified

48 | Suraj Dharamraj Patel 31 qualified

49 | Vaishnavi Kundan Patil 35 qualified

50 | Sanskruti Santosh Patkar 12 disqualified
51 | Amey Subhash Pawar 43 qualified

52 | Shubham Suresh Pawar 44 qualified

53 | Vishal Mohanrao Pukale 29 qualified

54 | Prachi Narendra Punde 43 qualified

55 | Chirag Sunil Ranpise 33 qualified

56 | Aditya Mahesh Rasal = 36 qualified
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57 | Ashish Ravindra Salunkhe 19 disqualified
58 | Seema Gulab Shah 37 qualified
59 | Gargi Rajendra Shetye 45 qualified
60 | Manasi Sanjay Shinde 42 qualified
61 | Ritesh Yashwant Singh 42 qualified
62 | Vaishnavi Vijay Sinkar 36 qualified
63 | Ashutosh Kiran Sonar 35 qualified
64 | Atharva Sanjay Sonone 37 qualified
65 | Anurag Sunil Sukumaran 43 qualified
66 | Gayatri Balasaheb Sanap 33 qualified
67 | Nishant Jagdish Chaudhari 36 qualified
68 | Sakshi Chandrakant Biradar 35 qualified
69 | Shivani Babasaheb Jadhav 37 qualified
70 | Vipul Prakash Chaudhari 43 qualified
71 | Gauri Rajaram Lokhande 44 qualified
72 | Shaikh Irfan Shahabuddin 45 qualified
73 | Rushikesh Sangale 42 qualified
74 | Shinde Harshad Anand 42 qualified
75 | Prathamesh Suraj Mane 36 qualified
76 | Nikita Vinayak Sartape 35 qualified
77 | Himanshu Tukaram Sarode 37 qualified
78 | Sahilkumar Binay Sinha 43 qualified
79 | Mohanish Kishor Sarode 33 qualified
80 | Chaitanya Thonge 36 qualified
81 | Gagan Matkar 35 qualified
82 | Sayali Vasant Pachpute 37 qualified
83 | Vaishnavi Sopan Mavale 43 qualified 7
84 | Deshpande Abhishek Ambadas 44 qualified
85 | Shiv chandan yandralwar 29 qualified
86 | Sayali Sanjay Birje 45 qualified
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87 | Vedant Rajendra Chaudhari 42 qualified
88 | Thorat Aarti Nandkumar 42 qualified
89 | Nikita Fula Patil 36 qualified
90 | Thorat Aarti Nandkumar 35 qualified
91 | Pratik Rajendra Potdar 37 qualified
92 | Janhavi Kiran Chaudhari 43 qualified
93 | Shruti Vijay Mahajan 33 qualified
94 | Abhijit santosh thange 36 qualified
. 95 | Bhakti Tukaram Kate 35 qualified
96 | Prajwal Purnapatre 37 qualified
97 | Vaibhav Bhagwat Pangare 43 qualified
98 | Pranita Bajirao Raut 44 qualified
99 | Kale Kunal Subhash 29 qualified
100 | Mrunmayee Kailas Shewale 31 qualified
101 | Vaishnavi Sopan Mavale 35 qualified
102 | Deshpande Abhishek Ambadas 45 qualified
103 | Shiv Chandan Yandra war 42 qualified
104 | Sayali Sanjay Birje 42 qualified
105 | Vedant Rajendra Chaudhari 36 qualified
106 | Thorat Aarti Nandkumar 35 qualified
) 107 | Nikita Fula Patil 37 qualified

EventCoordinator

Pi{ncipal




Nutan Maharashtra Vidya Prasarak Mandal’s

NUTAN MAHARASHTRA INSTITUTE OF
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Request for organization an Event

Academic Year: 2021 -2022

Department: Information Technology Date: 18/08/2021

To,
The Principal,
Through: The HOD (IT)

Subject: Permission for organizing Add-on-course on Advanced Excel for SE, TE, BE Students

Respected Sir,

In context to above subject, we request you permission to organize Add-on-course on Advanced Excel

¢ Name of Event: Advanced Excel add-on-Course.

e Duration (dates/time): 23™ Aug to 27" Aug,2021/9:00 am to 4:00 pm
e Budget: NIL

» Sponsorship (if any)

o Affiliations (if any)

Thanking You.
Y outs faithfully,
Coordinator: Prof. Swati Khalde
Remarks:
P . aahara \\\\\ Prof. Nitin Dhawas
4 A Head of the Department
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DataLookup

Data Cleaning
Pivot Tables:
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MONDAY _ MONDAY
23 August ~ 27 August




Day & Date Time Topic
9.00 am to Pivot tables:
12.30 pm e Creation of Pivot table
o Calculated Field in pivot table
o Comparative analysis in Pivot table
e Using grouping and ungrouping in pivot tables.
Monday e Pivot chart _
o Difference between regular and pivot chart
. Solver function:
(7 hrs) 4:00pm
Scenarios:
Data table:
Data Management:
9.00 am to Sorting, Filtering Data, Data Subtotaling, Grouping &
12.30 pm outlining data
Tuesday
24/08/2021 — ——— ‘
(7 hrs) 1:00 pm to Data Validation, Consolidation, Formatting &
4:00pm Conditional formatting
Lookup Functions, Mathematical Functions, Text
9.00 am to Functions
Wednesday 12.30 pm :
25/08/2021 1:00 pm to Database Functions, Date & Time Functions, Financial
(7 hrs) 4:00pm Functions
Isblank, Iserr, Iserror, Islogical, Iseven, Isodd, ISNA
o 0famito functions, general functions, macros basics
Thursday 12.30 pm : ;
26/08/2021 1:00 pm to
(7 hrs) 4:00pm Naming range, referencing, Formulas auditing
9.00 am to Fill series, Security of Workbook & Worksheet
Friday 12.30 pm
27/08/2021 1:00 pm to
(7 hrs) 4:00pm Analyzing Data with the Analysis ToolPak, Assessment

i\
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Report of the event organized

Academic Year: 2021 -2022
Department: Information Technology Date: 31/08/2021

To,

The Principal,

Through: The HOD (IT)

Subject: Submission of the Report of add-on-course on Advanced Excel for SE, TE, BE Students.
Respected Sir,

With above reference, we have successfully organized and completed Student add-on-course on
Advanced Excel for SE, TE, BE students on 23" Aug to 27" Aug, 2021. The details are given below.

No. of Participants: 230

Faculty Coordinator and Members:

Sr. No. Date & Time Title Important details of events
1 23" Aug to 27" Add-on-course Advanced Excel | 230 Students attended add-on-
Aug2021 course
9:00 am to 4:00 pm

Thanking You.

s

Coordinator: 1) Prof. Swati Khalde

......

), : i
N, i nahar X Prof. Nitin Dhawas
iy, : .\ Head of the Department
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30 29 Ingrid 15.5
31 30 Jaime 15.5

32 31 Lilly 15.5
33 32 Rogelio 15.5
34 33 Joshua -, 15.5

35 34 Lindsay 15.5
35 Audra 15.5
36 Aubrie




MCQ FOR Excel
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+ ind cater raquired guestion

Name *

Your answel

Email 1D

Your answér

1.____isnot a valid data type in MS Excel.

1. Number 2. Character 3 Label
4 Date/ Time

O
Oz
Qs
04

W, 150 P 1400 FOR Excel

6. Why is the =COUNTIF function in Excel used?
1. Counts cells as specified

2. Counts blank cells in & range

3. Counts cells with numbers in a range

4 Returns values based on a TRUE or FALSE condition

o000

7.__is the programming language used to write a Macro in MS Excel.

1. visual Basic ¢+ 3. Java
4.C++

O
Oz
(@]
o)

"z

?—

2.____lagical function indicates TRUE only if all arguments are assessed as
TRUE and FALSE otherwise.

1.0R 2 AND aIF 4. ANDIF
(M}
Qe
(o)
Qs

is the correct syntax of IF() Function.

. =IF (logical_test, TRUE([value_if_truel), FALSE(lvalue_if_false]))

~

. =IF logical_test, [value Ji_truel [value_if_false])

3 =IF (logical_test, liﬁalue)(_lluz]).t[valuu_il_‘ﬂse])]

s

. =IF (logical_test: [value_if_true], [value__false])
[e 3]
Q2
(@]
Qs

E R L 0 FOR Enced

8. Which of the fallowing functions is used to find the highest value in a range?

1 MAX 2MIN 3.5UM 4.
AVERAGE

O
Q2
Qs
ok}

9. Which of the following functions is used to count the number of cells in a range
that meet specific criteria?

1. COUNT 2.COUNTA

3. COUNTBLANK 4. COUNTIF

(@Rl
Oz
Os
[oX]

10. In MS-Excel which functions will calculate the number of workdays between
6/9/2013 and 8/12/2013.

1. Workday 2.Date 3. NetworkDay
4. Weekday

QO
Q2
()R]
Qe

4, ___type of chart is goad for a single series of data.

1. Column chart 2. Cone chart o

3. Line chart 4. Ple chart

O

(@]

(® JiE ]

O :

5. What is an Excel featura that displays only the data in column (s) accarding to
specified critaria?

1. Filtering 2 Sorting 3. Formula
4.Pivot

O
Q2
Qs
QO

2z

LR W00 FOR Esced

11. In MS-Excel to protect a workshaat, you can choose Protection and the
Protect Sheal from the........... Menu,

1. Edit 2. Format 3, Toals 4 Alaf
these

Qo
(@]
ou §
O

12 Which of the following functions is used to calculate the average of a range of
cells, ignaring zero values?

1. AVERAGE 2 AVERAGEIF
3 AVERAGEIFS 4 AGGREGATE

O
Qz
Qa
QO

13. Which of the following functions s used to calculate the variance of a range of
ecells?
1. VAR 2. VARP 3STDEV 4. STDEVP

O
Q:z
(o]
O«



14, In M5-Excel 3- reference in a farmula

1. Cannat ba modified 2. Only appéears on
summary worksheets 3.Both1&2
4. Spans Worksheets

[oR
0O:2
O
Q4

15. What MS-Excel feature can you use if you want to work with one record at a
time?

1. Auto Complete 2. Auto Filter 3. Data Form
4, All of above

Q1
02
O3
Q=

16. Which of the following functions is used to round a number to a specified
number of decimal places?

1. ROUNDUP 2 ROUNDDOWN 3.ROUND 4. TRUNC

O

(O]

O3

[eX]
[ ]

P IRETLY e FOR Excd

22, In MS-Excel how can you find specific information in a list?
1. Select Tools » Finder from the menu

2 Click the Find biutton on the standard toolbar

3. Select Insert > Find from the menu

4 Select Data > Form from the menu 10 open the Data Form dialag box and click
the Criteria buttan

QO
Oz
0Oa
Qs

23. In MS-Excel when integrating MS-Word and MS-Excel, MS-Word is usually
the__

1. Server 2. Destination 3 Client 4.Both18&

O
O

(R} ‘\‘—-hﬁﬁ}

R LS A

17. In MS. hat chart abject is l or I ling that extends
mouthqplmImhmhhnaslermu-dlmtolawuunm?

1. Categary Axis 2. Data Marker
3poth 162 4. Gridline
O

Q2

Qs

Qs

18, In M5-Excel which el rksheet can be p d from 1l
modification?

1. Contents 2. Objects 3.Scenarios ERA
af these

O
Q2
Oa
Q4

19. In MS-Excel which of the follawing is an absolute cell reference?

1.1AN 2 $A51 3. #a1 4.
Hone of these

O
Q2
Os
ok}

A TR e FOR Exord

24. In MS-Excel Comments put in cells are called

1. Smart tip 2. Cell tip 3. Web tip 4.
None of these

O
Q2
(o]
(o)X}

25. In MS-Excel Book1 is an example of hiow . . . are numbared and named during
wach work session

1. Active cell 2. Formula bar 3.Menu bar 4
Name box

O
(8
[0 )]
O

Skl Cinar farm

Google Forms

20. In MS-Excel Documentation should include

1. Destination and users of the output data 2 Source of input data

4. All of the above

O
0z
Gra
(o]

3. Information on the purpose of the workbook

21. In MS-Excel chart wizard term data series refers to—

1. A chart legend
markers
4.None of these

QO
Oz
Oa
[oX]

2. collection of chart data
3. A set af values you plot in a chart

215724, 150 P

WG FOR Evcd
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SE Class
Roll no Name of Student Score Remark
1 DAREKAR OMKAR VIJAY 43 qualified
2 GHORPADE AKASH GAJANAN 44 qualified
3 BABAR LAXMAN VITTHAL 29 qualified
4 HANDE PRADIP KAILAS 35 qualified
5 HULAGE RUSHIKESH ARUN 37 qualified
6 GOSAVI ARYAN NARENDRA 43 qualified
7 SANAP YOGESH VISHNU 44 qualified
8 SARAK NETAJI TANAJI 37 qualified
9 SHIKALGAR FIROJA HARUN 45 qualified
10 HOLE MAYUR PRALHAD 42 qualified
11 SHIRURE OMKAR SATISHKUMAR 18 disqualified
12 KADADHEKAR PAYAL RAJESH 12 disqualified
13 DHUPE KIRAN VITTHAL 17 disqualified
14 LODHE AKSHAY SUBHASH 19 disqualified
15 UMARDAND MANALI MALLIKARJUN 18 disqualified
16 TAMHANE ADITYA DHRUVABAL 33 qualified
17 PAGAR YASH BHAUSAHEB 36 qualified
18 CHAKOLKAR PRATIK RAVINDRA 35 qualified
19 UDAVANT VEDAMRUTA JAYANT 37 qualified
20 GIRAMKAR JUILEE GANGADHAR 43 qualified
21 BORUDE ABHIJEET SUNIL 44 qualified
22 TILEKAR KUNAL DATTATRAY 29 qualified
23 BHIRUD YOGESH SUBHASH 31 qualified
24 PAWAR KOMAL SANJAY 35 qualified
25 BANKAR VISHAL KIRAN 43 qualified
26 GITE PRAVIN SHANTARAM 36 qualified
27 KHARAT ADITYA VIJAYKUMAR 18 disqualified
28 MAHAJAN PRATIK BALU 12 disqualified
29 KORGAONKAR PRATHMESH PRAKASH 17 disqualified
30 SAWANT PRATIK VASANT 19 disqualified
31 BHIRUD TEJAS BHAGWAN 44 qualified
32 MORE SUDARSHAN DAYANAND 36 qualified
33 AMANGE ADITYA VENKAT 36 qualified
34 PAPAT ESHA AJAY 33 qualified
35 RANMALE GANESH DATTA 36;__ g qualified
36 THAKUR APARAJITA BALRAMSINGH / 36ah ‘\ qualified
\
n M I Tate Ny f




37 GORDE PRATIKSHA RAJU 30 qualified
38 BHAGAT SIDDHESHWAR SUDAM 32 qualified
39 PARBAT TEJAS TUSHAR 35 qualified
40 SANKPAL DHANSHREE RAMHARI 27 qualified
41 KANTHALE MAHESH SATISH 49 qualified
42 RANA SEJAL MANOJ 46 qualified
43 PATIL VAISHNAV NANDKISHOR 39 qualified
44 PANASKAR VISHWAJEET PRAKASH 29 qualified
45 SOLANKE KRANTI BHAVANRAO 42 qualified
46 LOKHANDE PARTH PRASAD 43 qualified
47 CHOUDHARY PANKAJ BHOMARAM 14 disqualified
48 NAYAKWADI YASH UDAY 18 disqualified
49 WAGH SARVESH SANJAY 13 disqualified
50 AGIWALE SURAJ TANAJI 10 disqualified
51 MANE AKASH SANJAY KUMAR 14 disqualified
52 SHAIKH ROSHAN RAMJAN 17 disqualified

. 53 DAMBALKAR SAMRUDDHA SATISH 15 disqualified
54 MOHITE SAKSHI GANESH 18 disqualified
55 BORLE CHANDRAKANT SURYAKANT 36 qualified
56 THITE SAMEER SUNIL 36 qualified
57 SAWANT ADITYA MOHAN 39 qualified
58 SHENDKAR AKSHATA DNYANDEO 27 qualified
59 KASALKAR NIKITA NIVRUTHI 49 qualified
60 KULKARNI TANVI MUKUND 46 qualified
61 ARAJ VEDANT ANKUR 39 qualified
62 RAO SIDDHESHWARI VASUDEVAN 29 qualified
63 SUNDARKAR SHREYAL SANJAY 42 qualified
64 SHINDE HARSHADA ASHOK 43 qualified
65 KURHADE KETAN SUNIL 39 qualified
66 SONAWANE RAKESH HAUSHIRAM 29 qualified
67 CHAVAN ANKITA RAVIVARMA 31 qualified
68 NAIKNAVARE PREM SAMADHAN 18 disqualified
69 JADHAV ANURAG UTTAM 12 disqualified

. 70 CHIKHALE POONAM UMESH 17 disqualified
71 KARBHARI RUPESH VIJAYKUMAR 19 disqualified
72 KAKLIJ HRISHIKESH SAHEBRAQ 17 disqualified
73 WABLE SANGRAM SAMBHAJI 12 disqualified
74 WABLE ABHISHEK NANASAHEB 45 qualified
75 TIBOLE OMKAR RANJEET 49 qualified
76 PADEKAR TANMAY SATISH 12 disqualified
77 NAGTILAK SAKSHI SANJAY 17 disqualified
78 TALOKAR ANUJA SANJAY 19 disqualified

D
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TE Class
Roll Name of Student Score Remark
no
1 AAJURE NAGRAJ BASAVRAJ 33 qualified
2 GANGAVANE KHUSHAL SHIVAJI 36 qualified
3 DAWAKE VEDANT SUNIL 35 qualified
4 JAGTAP ONKAR SANDIP 37 qualified
. 5 PATIL JAYESH MILIND 33 quali‘fied
6 KANADE MANASI PRALHAD 36 qualified
7 VARUNKAR VAIBHAV GANESH 35 qualified
8 VYAVHARE KARAN HARISH 37 qualified
9 JANGAM SAMIKSHA KASHINATH 45 qualified
10 KUMBHAR ANIKET DEEPAK 42 qualified
11 BHUJBAL ROHIT DEVDAS 42 qualified
12 PATIL KSHITIJ KUNDAN 33 qualified
13 KHANDAGALE JANHAVI PRAVIN 36 qualified
14 SHARMA NEHAL DINESH 35 qualified
15 MAHAJAN ABHIJIT VIJAY 37 qualified
16 PAWASKAR NIDHI AJIT 14 disqualified
17 SONAWANE JAYESH SHIVAJI 18 disqualified
18 KHUTWAD BHAGYASHRI GORAK 13 disqualified
19 KALE TEJAS SHIVAJI 10 disqualified
20 GUPTA ADITYA 14 disqualified
21 PATIL KARTIKI NARAYAN 18 disquelll.iﬁed
. 22 YADAV VIKRAM 29 qual!ffed
23 MISHRA NISHI KUMARI 31 qualified
24 BHUTE ADITYA MUKUND 35 quaﬁf'{ed
25 KAUJALGIKAR ASHWINI DEEPAK a3 qualified
26 UDAGIRE DARSHAN SHIVAJI 36 qualified
27 PHATAK SACHIN SHIRISH 33 quali_f'fed
28 KOKATE TRUPTI BHAUSAHEB 36 qualff!ed
29 PATIL ROHIT PRASHANT 35 qualified
30 JADHAV SHUBHENDU VIJAYKUMAR 37 qual'!fied
31 RAORANE VRUSHABH SUBHASH 43 qualified
32 SAYYAD MOHSIN MUBARAK 12 disqualified
33 PURNAPATRE RIDDHESH SANDESH 19 iiisqualiﬁed
34 PATIL NIDHI SOMANAGOUDA 18 = di‘éma’rifﬂgd
35 | GAIKWAD AAKANKSHA RAJENDRA 13 disqualifiedy,
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36 RANE AISHWARYA DEVIDAS 11 disqualified
37 PAWAR SHREYASH MOHAN 30 qualified
38 KALE KEDAR ANIL _ 32 qualified
39 GAIKWAD SUMIT MAHAVIR 35 qualified
40 RAJPUT RAJATSINGH UMESHSINGH 33 qualified
41 GUJARATHI ATHARVA KISHOR 36 qualified
42 SHAIKH RIHAN SHAFIQ 35 qualified
43 BHOITE MAYURI VILAS 37 qualified
44 URKUDE RITU GYANESHWAR 39 qualified
45 KIRANGE ROHIT BHASKAR 42 qualified
46 JATHAR HARSHAL HANSRAJ 43 qualified
47 GUPTA AARTI OMPRAKASH 39 qualified
48 KAND KUNAL DATTATRAY 29 qualified
49 NAIR DEVIKA PRAKASAN 31 qualified
50 KHARAT PIYUSH NICHOLAS 43 qualified
51 SHINDE SAURABH SIDDHOO 39 qualified
52 GHUMATKAR SAKSHI SANJAY 29 qualified
53 SHINDE AKASH PRAMOD 31 qualified
54 OHOL TANVI ABHAY 42 qualified
55 PATIL MAHESH VASANT 43 qualified
56 MANDEKAR PRAJAKTA MACHINDRA 39 qualified
57 KADAM RUTUJA NITIN 34 qualified
58 DHANORKAR SHUBHAM DILIPRAQ 12 disqualified
59 BIRAJDAR MAHESH CHANDRAKANT 19 disqualified
60 SANGOLKAR SHRUTKEERTI DHANANJAY 17 disqualified
61 LOKHANDE SIDDESH DATTATRAYA 15 disqualified
62 BANGAR NILESH MATHAJI 12 disqualified
63 MULE SANKET ARUN 19 disqualified
64 PARRE KEVIN SAMSON 39 qualified
65 KALE MANGESH CHANDRAKANT 34 qualified
66 WAGHMARE ARNOLD JOSEPH 41 qualified
67 KONDEKAR VIDULA WAMAN 34 qualified
68 BANSODE ROHIT MOHAN 41 qualified
69 KADAM KRITIKA AUDUMBAR 45 qualified
70 JOHARI HARSHALI VASANT 43 qualified
71 MAGARE SUSHIL SUNIL 39 qualified
72 KHOBRAGADE NIKHIL SHRAVAN 29 qualified
73 GADEKAR VRUNALI RAJU 18 disqualified
74 VANJARI PALLAVI BAJIRAO 12 disqualified
75 JAGTAP SUPRIYA MAHENDRA 17 disqualified
76 RANA RISHU VINOD 19 disqualified
77 DONGARE VINAY VITTHAL 18 disqualified
78 GHADGE ROHAN HANUMANT 12 disqualified
N
s i b\ \
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BE Class
Roll Name of Student Score Remark
no
1 VAIBHAV GANESH SURVASE 43 qualified
2 NILAM ARJUN PANMAND 44 qualified
3 UTKARSH PRALHAD BHANGALE 29 qualified
4 SHUBHANGI SHAM MAHAJAN 31 qualified
5 ANIKET CHANDRAKANT SUTAR 35 qualified
6 RUTUJA DILIP DESHMUKH 33 quaiifﬁed
. ¥ NEHA SHASHIKANT GURDHALKAR 36 qualified
8 SANJANA SHASHIKANT GURDHALKAR 43 qualified
9 NIKITA VIJAY GAJARE 44 qualified
10 DURGESH PRAVIN PATIL 29 qualified
11 SUPRIYA RAMESH KUMBHAR 31 qualified
12 CHAUDHARI NIKITA SANJAY 35 qualified
13 SANHITA HEMANT DIVEKAR 33 qualified
14 AISHWARYA SHRIKRISHNA DESHMANE 36 qualiﬂ_ed
15 DARSHAN ASHOK BHOLE 43 qualified
16 AJAY DEEPAK BHUJBAL 12 disqualified
17 YASH MURLIDHAR BHAKRE 19 disquali.ﬂed
18 ADITYA SHANTARAM SAKORE 18 disqual!ﬁed
19 PRASHANT ANNASAHEB PAWAR 13 disqualified
20 ROHIT SANDEEP PRADHAN 11 disquali.ﬂed
21 SAYLI MADHUKAR CHAUDHARI 10 disquah.ﬁed
22 ZUBER RAHIM SHAIKH 12 disquc-.al'lﬁed
. 23 SUJATA SUNIL JUNARE 31 qualffl.ed
24 ADITYA SOMNATH GHODEKAR 35 quall.f!ed
25 TAKALE PRANJALI SANJAY 33 quah‘flled
26 VIVEK KANTILAL BHAVSAR 36 quah-f!ed
27 UJJWALA ROHIDAS BHOR 31 quallfl_ed
28 SAMPADA BALKRUSHNA DHORE 35 qual'!ﬂed
29 AJAY SOMNATH THAKAR 33 quall_ﬁed
30 KEDARNATH LAXMAN ROKADE 36 quah.f{ed
31 PADWAL SHRUTI SHRIKANT 31 qual{f!ed
32 MAROOF ABRAR KHAN 35 quahfn.ed
33 BHARTIHIROSHIMA SHIVKUMAR RAO 14 disqualified
34 TANVI PRAVIN KOTHARI 18 disqualified
35 | VEENA DILIP BHAGADE 13 _disqualified,,
36 | KHUSHBOO SURYAKANT KATE 10 ‘ disquailﬁgd_f,l_. _

)




37 PRAJAKTA SANJAY SURYAWANSHI 14 disqualified
38 AKHILESH ANUPAM KULKARNI 32 qualified
39 GAURAV MAHADEV RAJUKAR 35 qualified
40 PRABHANJAN SITARAM RAMDAS 39 qualified
41 PRATHAMESH MANJABHAU GADHAVE 42 qualified
42 PRANAV SANJAY CHINCHWADE 43 qualified
43 ANKEET DAYAL DOLWANI 39 qualified
44 | ANKRUTA AKARSHI PATRA 29 qualified
45 AISHWARYA DILIP DESHMUKH 42 qualified
46 PRANALI PRADEEP SAKPAL 43 qualified
47 AMAN HANIF SHAIKH 39 qualified
48 SACHIN VIJAY TENDULKAR 29 qualified
49 PRATHAMESH BHIMRAO GAIKWAD 31 qualified
50 ATHARVA MILIND JOSHI 39 qualified
51 PRATIKSHA DNYANDEV MANE 42 qualified
52 ASHISH RANJAN NAYAK 43 qualified
53 SHRUSHTI SANJAY UMALKAR 39 qualified
54 VIKRAM RAJESAHEB SHINDE 18 disqualified
55 DESMOND CHRISTO RODRIGUES 12 disqualified
56 ADITYA MAHESH KAREKAR 17 disqualified
o7 MOHIT CHIRANJILAL KUMAWAT 19 disqualified
58 EEIE\E:S’:!]REE CHANDRASHEKHAR 18 disqualified
59 NISHA NARAYAN GAIKWAD 12 disqualified
60 SHIVAM BIPIN KOBAL 46 qualified
61 SHRUTI DHANAJI KALE 39 qualified
62 VAISHNAVI SANJAY AMBAWALE 29 qualified
63 ROHIT SANDEEP IPARKAR 40 qualified
64 ANIKET NAMDEV JADHAV 39 qualified
65 BHAVIN MAHENDRA PATIL 34 qualified
66 JUSTIN SHAHAJI THOMAS 41 qualified
67 ACHAL DEEPAK BUTE 40 qualified
68 ASHISH ANIL HALLE 39 qualified
69 SHRUTIKA VILAS MORE 34 qualified
70 ANKITA ANANDA SABALE 18 disqualified
71 AMRUTA SANJEEV OVHAL 12 disqualified
72 RUSHIKESH SADANAND KAMBLE 17 disqualified
73 SAYALI DILIP DESHMUKH 19 disqualified
74 PURVA GANPAT DHURI 14 disqualified
75 CHAITANYA VIKRAM NAIR 18 disqualified




